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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in May 2025

Sector Indices vs HSI / HSCEI

CES120 vs China Theme Indices

Index Name
HS Mainland
0
MSCI China A 50 Index F +1.7%
% Change

Equity Index Futures Access Codes

Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv O0#HMBI: O0#HCHH: O#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 30 May 2025

Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products HSI Futures (YoY) HSI Options (YoY)
(2025 vs 2024)

Av erage Daily Volume Open Interest Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts) (No. of Contracts) (No. of Contracts)
0 0 280,000 - mmmmmm ADV (L-Axis) - 200,0 60,000 - ADV (L-Axis) - 400,00
HSI Futures 138,150 (-2%) 122,983 (+3%) 240,000 - Open Interest (R-Axis) Open Interest (R-Axis)
200,000 - ,\/\’ 150,000 45,000 - - 300,000
160,000 -
o - 100,000 30,000 - 200,000
Mini-HSI Futures 112,000 (+16%) 11,793 (-16%) 120,000 -
80,000 1 - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0 =+ 0
HSI Options 16,720 (-15%) 67,091 (-4%) D0 X NP B D0 O N DG
S S S S S S S S S S
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 14,100 (-19%) 26,561 (+39%)
Av erage Daily Volume Open Interest Average Daily Volume Open Interest
(No. of Contracts) No. of Contracts]
00,000 ADV (L-axis) M SEXEEE 30,000 | - ADV (L-Axis) 21881600
. Opgn Interest (R-Axis) e Ope N Interest (R-AXis)
HSI Futures
-3120, -R0, 4 L
Options 3,005 (-33%) 46,198 (-6%) 150,000 i I I 150,000 20,000 m - 100,000
100,000 - ' - 100,000
. 10,000 - - 50,000
HSI Volatility 00) 0() 50,000 - - 50,000
Index Futures
07 r 0 0 as >0 > 0
L Soat >0 =oa > SS5S220 Sg8as
HSI Dividend 5338858588238 5333858823528
Point Index 24 (-56%) 2,581 (+63%) SR oo2a | 2008
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 May 2025
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most (1000)
Index Description . ) .
liquid stocks listed in Hong Kong 26 - - 52 130 - HSI Index Tencent
———HS| =——VHSI
Index Level 23,289.77 (As at 30 May 2025) HSBC —— BABA
Xiaomi Meituan
- . . 24 - 44
Index Volatility (30-Day Historical) | 27.9 110 -
Index Avg. Day High-Low Range 288.58 (May 2025) 29 - L 36
HSCEl Correlation (2025) 0.993 90 -
20 - - 28
Hang Seng Index Futures 18 ; ; 20 70
Mar-25 Apr-25 May-25 Mar-25 Apr-25 May-25
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.16Mn (As at 30 May 2025) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction Cost*
=)
Stamp Duty NA 3 :8./ 31.0
S 310 b o
Trading Fee HK$10 / contract kst =
L 240 £ 240
SFC Levy HK$0.54 / contract = =
% 5
Commission Rate Negotiable & 17.0 5 17.0
e} =
c
Margin as of 29 May 2025 HK$126,400
10.0 | . . , 10.0 | , ,
0 1 2 3 0 1 2
Open Interest ("000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 May 2025
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products AV HSCEI Futures (YoY) HSCEI Options (YoY)

(2025 vs 2024) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-Axis) - 700,000 120,000 + ADV (L-Axis) - 2,800,000
Open Interest (R-Axis) Open Interest (R-AXis)
i - 600,000 i - 2,400,000
HSCEI Futures 167,824 (-11%) 252,206 (-5%) 200000 [ e00.000 100,000 [ 300,000
160,000 - ’ 80,000 - e
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 H
Eut SC 11,491 (+12%) 3,039 (-32%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - -0 o ++ 111150
5 O A 9 N D& S 0 A 9O N D&
. B S S S S B S S S S
HSCEI Options 18,568 (-40%) 286,878 (+4%)
HSCEI Futures (MoM) HSCEI Options (MoM)
Mini HSCEI Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
. of .
Ontions 3,068 (_24%) 18,399 (+28%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) ADY (L) (No. of Contracts)
P 275,000 - mmmmm ADV (L-AXis) T 600,000 50,000 - Open Interest (R-Axis) | 600,000
Open Interest (R-Axis)
220,000 - 40,000 -
HSCEI Futures i l - 400,000 i
: 39,824 (-3%) 814,094 (+30%) 165,000 - 30,000 400,000
Options 11 I i ’
110,000 - i
- 200000 20000 - 200,000
HSCEI Dividend 55,000 - 10000 -
Point Index 443 (-65%) 34,224 (+31%) '
Futures L PE—— s 0 0
5338339588 5% csoag2cags >
SPZnO0zahu=<s ';’.9,2:%828&@2%%
2024 2025 2024 2025

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 May 2025
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

. Comprises the largest and
Index Description P d

most liquid H shares 107 4 140 -
e H S| em—HSCEI| e H SCEI Xiaomi
Index Level 8,432.02 (As at 30 May 2025) —— Tencent = BABA
105 - CCB Meituan
Index Volatility (30-Day Historical) | 30.4 120 -
Index Avg. Day High-Low Range 118.92 (May 2025) 103 | 100 W"‘

Correlation with HSI, CES120 (2025)| 0.993,0.976

: . 101 1 80
Correlation with CSI300, FTSE A50 0.829.0.789
(2025)
99 T T T T 60
2-May 9-May 16-May 23-May 30-May Mar-25 Apr-25 May-25
HSCEI Futures
Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.42Mn (As at 30 May 2025) Call Put
15.0 150
=)
Iy oo
ransaction Cost -~
S 110 8110
Stam p Duty N/A .3 o
& 90 290
) 5
Trading Fee HK$3.5 / contract = 70 ‘Q 7.0
7] )
=]
SFC Levy HK$0.54 / contract 3 50 £50
i=
Commission Rate Negotiable L 3.0 . . )
0 2 4 6 8 10 12 14 0 4 8 12
Margin as of 29 May 2025 HK$49,350 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference only

As at 30 May 2025
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50 Volume
i i i (No. of Contracts)
Liquidity Providers QBN, BhNP, C|t$1del,KEcI|pse, IMC, Optiver,
usquehanna, Yue run 25,000 - m Weekly HSI Options
m Weekly HSCEI Options
Transaction Cost* 20,000 ® Weekly HSTECH Options
Stamp Duty
15,000
Trading Fee HK$1O / contract
SFC Levy HK$0.54 / contract 10,000
Commission Rate Negotiable 5 000
Weekly HSCEI Options 0
Contract Multiplier HK$50 £ g g g g £ £ g g g g g g g g g g g g g
Lo . ABN, Citadel, Eclipse, IMC, Optiver, T T A A A e e e Ao
Liquidity Providers
Susquehanna
Volume
(No. of Contracts)
Transaction Cost* 20.000 - .
Stamp Duty ’ ==\ eekly HS| & HSCEI &HSTECH Optlo-ns Call
T i Fa HK$3_5/ P— 15.000 e \\eekly HS| & HSCE| & HSTECH Options Put
SFC Levy HK$0.54 / contract
Commission Rate Negotiable 10,000 -
5,000 -
Contract Multiplier HK$50
Liquidity Providers ABN, Eclipse, IMC, Optiver, Susquehanna 0 — 7T T T T T T T
0N 0 LwLwmwmwwwmLwLmwmwLmwmLwmWwmwWwLwmLwmLwmLw
NORDBISFTAMINODOS ITNMON B O O
1 N NN NN N NANM
Stamp Duty N/A
Trading Fee HK$5 / contract”
SFC Levy HK$0.54 / contract
Commission Rate Negotiable

"Trading fee discount at HK$2.5, until further notice

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference only
As at 30 May 2025



Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2025 vs 2024) _— No. of Single Stock Derivatives

Stock Futures 9,889 (+18%) 25,232 (+2%) Single Stock Futures
Stock Options (Monthly and Weekly) 897,710 (+25%) 14,590,716 (+33%) Single Stock Options 132
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
12,000 1 s ADV (L-Axis) . - 40,000 1,000,000 - ADV (L-Axis) - 16,000,000 SIS/ AT
| Open Interest (R-Axis) Open Interest (R-Axis)/' |- 14,000,000
10,000 800,000 -
- 30,000 ' - 12,000,000
8,000 - * Products
! 600,000 - - 10,000,000
6.000 - - 20.000 ' - 8,000,000 > 3 A-shares ETFs futures contracts
4,000 4 400,000 - - 6,000,000 » Total 97 stock futures contracts
’ - 10,000 200,000 - - 4,000,000
2,000 - - 2,000,000
O 0 T T T T T T T T T T T T O
TP I A I
$ S S S
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) _ (No. of Contracts) » 3 A-shares ETFs options contracts
. e ADV (L-Axis) i 1,400,000 - ADV (L-Axis) - 20,000,000 i
18,000 Open mtereatdR-Axis) [ 20000 Open Interest (R-Axis) > Total 132 stock options contracts (10 of
16,000 1 1,200,000 - . 16.000.000 them are weekly stock options”)
14,000 - - 40,000 ,000,
14,000 { 1,000,000 - /—\/\_,
10,000 - - 30,000 800,000 - - 12000000 . Market Makers (MMs)
8,000 - - 20,000 600,000 - - 8,000,000 > 3 types of market makers (PMM/ CQMM/
6,000 - 400,000 - QRMM)
4,000 - - 10,000 590000 - - 4,000,000 ) _ _
2,000 - ' » CQMM to provide 50 series continuous
0 -0 0 0 uotations
csoo SS928395855% q
S°ZH SPIZn0zosu=<=s A Alibaba Group, Baidu, BYD, HKEX, HSBC, JD.com,
2024 | 2025 2024 | 2025 Kuaishou, Meituan, Ping An, Tencent

Data Source: HKEX
* Ol compared to previous year-end
Information for reference only

As at 30 May 2025
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 30 May 2025)

Tracks the largest technology companies
Index Description
listed in Hong Kong Open Interest
(No. of Contracts)
400,000 -
Hang Seng TECH Index Futures & Options & Futures Options
Contract Multiplier HK$50 per index point 350,000 -
Notional Value (1 Contract) HK$259K (As at 30 May 2025) 300.000 -
No. of Liquidity Providers N/A
250,000 -
Transaction Cost* 200.000
Stamp Duty N/A %:3,%%‘588%885%‘
(@) L =S <
Trading Fee HK$2.50 / contract ” < 0 z 0 | ” = |
SFC Levy HK$0.54 / contract 2024 2025
Average Daily Volume (as of May 2025)
ADV
(No. of Contracts)
250,000 -+

200,000 -
150,000
100,000
50,000 -
0 -

_Q S
o
i <

2024 2025

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of HK$2.50 per contract ( the standard trading fee is HK$5.0 per contract)
Information for reference only

As at 30 May 2025

X o

Volume and Open Interest continue to growth



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of May 2025)

L Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
Index Level 2,089.79 (As at 30 May 2025) (No. of Contracts)
25,000 -
Index Volatility (30-Day Historical) | 10.4 20 000

Index Avg. Day High-Low Range 16.93 (May 2025) 15,000
CSI300 Correlation (2025) 0.972 10,000
FTSEA50 Correlation (2025) 0.976 5,000

0

MSCI China A 50 Connect Index Futures

2024 | 2025 |

Contract Multiplier US$25
Notional Value (1 Contract) US$0.05Mn (As at 30 May 2025) Open Interest (as of 30 May 2025)
Average Quote Size US$0.26Mn (5 Contracts)
Open Interest
(No. of Contracts)
19,000 -
Transaction Cost*
Stamp Duty N/A 15,000 -
Trading Fee US$0.5 / contract
11,000 -
SFC Levy US$0.07 / contract
Margin as of 29 May 2025 US$3,220 7,000 —
E 5 © 2 B8 2 9|l 2o 5 5 >
S A5 = [ o GJ © (0} ©
- < v © 2z o> UL = < =
2024 | 2025 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees, the Exchange is offering market-wide 50% trading fee discount of US$0.5 per contract (the standard trading fee is US$1.0 per contract)
Information for reference only

As at 30 May 2025
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MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$56K (As at 30 May 2025)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference only

As at 30 May 2025

X

Open Interest (As of 30 May 2025)

Open Interest
(No. of Contracts)

160,000 -

140,000 -

120,000 -

100,000 +

80,000 -

60,000 — .
2024 | 2025

Average Daily Volume (As of May 2025)

ADV
(No. of Contracts)

40,000 -
30,000 -
20,000 -
10,000 -

0 .

2024 2025

Volume and Open Interest continue to growth
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2025)

HSCEI Correlation (2025)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

624.45 (As at 30 May 2025)
14.5

5.74 (May 2025)

0.862

0.831

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$62K (As at 30 May 2025)
US$0.31Mn (5 Contracts)

1.2 index points (May 2025)

Flow and 11 banks

Transaction Cost*

Stam p Duty
Trading Fee
SFC Levy

Margin as of 29 May 2025

N/A
US$0.5 / contract
US$0.07 / contract

US$3,960

Open Interest
(No. of Contracts)

Open Interest (30 May 2025)

18,000 -
12,000 -
6,000 -
0
S 39 %8 3855553
h'_’<</)ozo'->|$§<§
2024 | 2025 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAXJ e MSCI China MSCI HK
140 MSCISG e MSCIindia e MSCI Indonesia
------------- MSCI Korea - MSCI Malaysia MSCI Pakistan
------------- MSCI Philippines -+ MSCI Taiwan MSCI Thailand
120
100
80 -
60 T T
Mar-2025 Apr-2025 May-2025

Futures contracts have relatively lower transaction costs

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference only

As at 30 May 2025

X

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance
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Hang Seng Mainland Banks Index Futures Performance

5-Min Avg. Bid-Ask Spreads (30 May 2025)

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2025)

HSCEIl Correlation (2025)

10 largest and most representative
HKEX-listed mainland banks stocks

3,748.80 (As at 30 May 2025)
14.4

38.40 (May 2025)

0.81

0.819

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stam p Duty
Trading Fee
SFC Levy

Margin as of 29 May 2025

HK$50

HK$0.19Mn (As at 30 May 2025)
HK$0.94Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$11,110

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 May 2025

X

Minsheng Bank 1988.HK

Bank of China 3988.HK

HSMBI Futures
CEB Bank 6818.HK 0.37%
ABC 1288.HK
PSBC 1658.HK

CITIC Bank 998.HK
Bankcomm 3328.HK
ICBC 1398.HK

CM Bank 3968.HK
CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)

——HSMBI ——CCB (939.HK)

120 -
ICBC (1398.HK) BOC (3988.HK)
——ABC (1288.HK)

110 -
100

90

80 T .

Mar-2025 Apr-2025 May-2025

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (30 May 2025)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
CSI300 Correlation (2025)

FTSE A50 Correlation (2025)

CES120 Index Futures

Contract Multiplier

Notional Value (1 Contract)
Average Quote Size

Average Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 29 May 2025

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

80 A-Shares and 40 HK-listed Mainland

China H-shares, P-chips, and red chips
CES120 Futures

6,410.13 (As at 30 May 2025)

14.3
ChinaAMC CSI300 ETF (3188.HK)
67.55 (May 2025)

0.896
CSOP FTSE A50 ETF (2822.HK)
0.871

X iShares A50 ETF (2823.HK)

HK$50
HK$0.32Mn (As at 30 May 2025)
HK$1.60Mn (5 Contracts)

N/A

120 e CES120 Index

N/A —Ping An

110

100
N/A
HK$5 / contract 90

HK$0.54 / contract

NA

_

CES120 & Top Constituents’ 3-Month Performance

0.19%

0.17%

0.13%

Rebased to 100

Tencent CCB

——— China Mobile

80

ALl Mar-2025

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 May 2025

X

Apr-2025

May-2025

CES120 Futures can be used to hedge A-share positions
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Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15 am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

: Hang Seng China Enterprises .
Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month + Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & bec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)

The second last trading day of the contract month (monthly contracts)

Expiry Day The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Iltem : . .
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options

Exercise Style European Style
Quoted in whole index points

Index points | Strike interval Index points Strike interval

Short-dated Options: Long-dated Options:

Option Premium

Strike Price > 20,000 200 > 20,000 400
> 5,000 and < 20,000 100 > 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

Trading Hours

Expiry Day
Settlement on
Exercise

Official Settlement
Price

Exchange Fee

Data Source: HKEX

X

(Closed at 4:00 pm on the Expiry Day)
The third Friday of the contract month

Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Average of quotations of the Index Futures Contract of the same contract month,
taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options

HK$10.00 HK$3.5 HK$5.0
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X

22



Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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